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Introduction to MemberMouse 1-Click Registration

Thank you for purchasing MemberMouse 1-Click Registration!

MemberMouse 1 Click Registration allows you to register new members or upgrade existing members
to any free membership level by doing only one action - clicking a link!

So once a user clicks on the link, he will be automatically registered to the relevant membership level
as defined in the plugin’s settings.

The plugin supports ALL autoresponders that integrate with MemberMouse:

(@ AWeber|Contact

EMAIL MARKETING TEMPLATES

Options to Registering Members:
There are 3 options to register members using MemberMouse 1-Click Registration:

1. Register through your autoresponder - By adding a unique registration link to emails you
send through your autoresponder

2. Roll members from another membership site — By adding a unique link to one membership
site and rolling the members to another membership site

3. Add a 3-field registration form - By embedding a simple 3-fields signup form to any post or

page
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Complete Activation Process Summary in 8 Steps

Follow the steps below to have MemberMouse 1-Click Registration activated and fully function on
your membership site.

Detailed information about each step will be given further down this manual:

Step #1: Plugin Download

Download MemberMouse 1-Click Registration Core plugin zip file from the Purchase Receipt you
received to your email.

Step #2: Plugin Installation & Activation

Install the plugin just like any other WordPress plugin from the Plugins menu > Add New.

Step #3: License Activation

Activate the plugin's license using the license key you received to your email.

Step #4: Defining the General Settings

Before generating the links you will need to go over the general settings of the plugin that can be
found in the Settings tab.

Step #5: Generating the Links

In order to generate the links or the signup form you will need to go to the Generator tab and define
the relevant settings.

Step #6: Embedding the Links

After defining the settings and generating the links all you need to do is copy-paste them to the right
place according to their use.

Step #7: Using the Shortcodes

In the Dashboard tab you will find all the shortcodes that can be copy-pasted to the After Registration
page to display the member his login details.

Step #8: Testing the Registration

After you copy-pasted the links or signup form to the right location you need to test them and make
sure they are working correctly.
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Step #1: Plugin Download

Download MemberMouse 1-Click Registration plugin zip file from the Purchase Receipt you received
to your email as seen in the screenshot below:

HAPPY PLUGINS

THE STORE &
Hello Motti,

Thank you for purchasing with Happy Plugins Storel

The items you purchased are listed below, along with all file download links.
These download links expire in 72 hours, please download your files right
away!

Links already expired?

Please H:Jgin to your account to download the products' zip file and manual.
Products

+ MemberMouse 1-Click Registration — Single Website
MembermMouse 1-Click Registration - Plugin (Z1P)
Membertdouse 1-Click Reqistration - Manual (PDF}

Your license keys (if any):
Memberhouse 1-Click Registration - Single Website:
Sch 81

Invoice Information

Invoice Date: 18/04/2016

Invoice # ec3596dbaz293d44e247ebbde6545e2aa
Purchase # 23478

Payment Method: manual_purchases

Total price: $0.00
Address

Best regards,

The team at HappyPlugins
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Step #2: Plugin Installation & Activation

MemberMouse 1-Click Registration plugin can be installed easily, just like any other WordPress plugin.
You can install it 2 ways:
1. Upload the folder found inside the zip file to your plugins’ folder in your WordPress installation

2. Go to the plugins menu, click the "Add New" and choose the zip file you have downloaded
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Step #3: License Activation

After you have installed and activated MemberMouse 1-Click Registration, you will find the plugin's
activation setting inside the WordPress menu under: MM Extensions » MemberMouse 1-Click
Registration.

To activate the plugin you purchased, you need to insert the license number in the right place under
"License Key" as seen in the screenshot below:

MemberMouse 1-Click Registration - Activate License

Fill in the license key for MemberMouse 1-Click Registration,

[You can find the license key inside your account or in the email you got when you purchased Memberttouse 1-Click Registration)

License Key Enter your license key
Activate License Activate License
Current License Status Mot Active

Having License Problems?

This can be caused due to the following scenarios

1. The license key you have entered is wrong — Copy the license key from your account in Happy Plugins Store

2. You have reached your license activation capacity - Please purchase more licenses

You can always buy more licenses for this product at: MemberMouse 1-Click Rapistration
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Finding Your License Key

You have 3 options to finding your licenses keys:

1. Go to My Account » Purchases and click on the key icon:

Purchases Profile

D Date Amount  Details License
#197 December 26, 2013 $0.00 View Details and Downloads ClickBank Cancel Notifications for Wishlist Memb
#140 December 23, 2013 $15.00 View Details and Downloads Clickbank Redirection &~

Next ©@

2. When you finish the purchase process:

Purchase Confirmation

Thank you for yaur purchase!

Payment: #4197

Date: December 26, 2013

Payment Status: Compiete

Subtotal 5000

Total Price: $0.00

Payment Method: Free Purchase

License Keys:

ClickBank Cancel Motfications for WWishiist Member [ ]
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3. In the purchase receipt that was sent to your email:

HAPPYPLUGINS

THE STORE &
Hello Motti,

Thank you for purchasing with Happy Plugins Storel

The items you purchased are listed below, along with all file download links.
These download links expire in 72 hours, please download your files right
away!

Links already expired?

Flease login to your account to download the products' zip file and manual.
Products

+ MemberMouse 1-Click Registration — Single Website
MemberMouse 1-Click Registration - Plugin (£1P)
MemberiMouse 1-Click Registration - Manual (PDF)

Your license keys (if any):
MemberiMouse 1-Click Registration - Single Website:

968 1 <—

Invoice Information

Invoice Date: 18/04/2016

Invoice # ec3596dba293d44e24T7ebbdet545e2aa
Purchase # 23478

Payment Method: manual_purchases

Total price: $0.00
Address:

Best regards,
The team at HappyPlugins
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Step #4: Defining the General Settings

Before generating the links you should go over the general settings of the plugin that can be found in
the Settings tab.

In the Settings tab you can set the following options:

e Link Expired Error Page — The page users will be redirected to if the registration link is
expired (The expiration date is set in the Generator tab)

¢ General Error Page - The page users will be redirected to in case of an error in the
registration process

¢ Send Email to Admin - Get admin email notification every time a new user registers through
a MemberMouse 1-Click Registration plugin registration link / signup form

e New Member Username Format - Set the username format to be first and last name, email
prefix or full email

e Member Welcome Email - The welcome email members get when the registration is
completed successfully

o Admin Notification Email - The notification email the admin gets every time a member
registers

Screenshots:

ﬂ Dashboard Settings Generator License Infermation Support Other Products

MemberMouse 1-Click Registration - Settings

Link Expired Error Page Homep

General Error Page

Send Email to Admin

New Member Username ®' First name & Last name Email Prefix Email Address
Format
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‘Welcome Email Subject: Welcome to our memi@

Welcome Email: Fill in the welcome email a new member will get when a he register to the membership site.
Depending on your MemberMouse Registration Widget settings you can use few the shortcodes to
Visual Text

B I == E &= =

PREXE

lih

»

Hi {{first_name}},
Thanks for joining our community!
You can login with the following credentials:

Username: {{username}} %

s

Admin Email Subject: A new member was regi

Admin Notification Email: Fill in the welcome email o new member will get when a he register to the membership site.
Depending on your MemberMouse Registration Widget settings you can use few the shortcodes to

Visual  Text

B I =& kE & - = =

SRREXE
A new member was registered,

Thanks for joining our community!

Member Details:
First Name: {{first_name}}
Last Name: {{last_name}} =
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Step #5: Generating the Registration Links

With MemberMouse 1-Click Registration you have 3 different and unique registration options:

e Autoresponder registration link - Register members via your autoresponder
¢ Rolling members' registration link - Roll members from another membership site
e Signup form - Register members via a simple 3-fields signup form

The registration links / signup form can be generated via the Generator tab under MM Extensions »
MemberMouse 1-Click Registration.

The Generator Tab:

e Select a membership level - The membership level members will be registered to when
clicking the registration link

e Select the membership bundle/s - The bundles members will be registered to when clicking
the registration link

o Select the autoresponder you are using - In order to generate the correct link so members
will be automatically registered straight from the email you send

o Select the after registration page - The page members will be redirected to after the
registration

¢ Automaticlogin after registration — Can be Yes or No

e Setan expiration date - If you want to link to expire you can set an expiration date for the
link (optional) to create urgency

o Math Captcha - Relevant to the signup form and allows you to add math Captcha to the form
to prevent spam registrations

f_.:/ HAPPY PLUGINS
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Screenshot:

%' Dashboard Settings Generator License Information Support Other Products

MemberMouse 1-Click Registration - Generator

Select a membership level Free Membership v

Choose a membership level that a new member will be registered to.

Select a membership bundles Bundle #1 2
Select AutoResponder -— Choose Your Autoresponder — v
(optional)

Choose your autoresponder to generate the correct link format for your specific autoresponder.

Select After Registration Page Homepage ¥

Choose the page a member will be redirected to after a successful registration is completed.
The after registration page can contain special shortcodes that will display the new member his membership information.

Login After Registration '8 Yes( I No

Choose whether or not the member will be logged in after the registration precess is completed.

Set Expiration Date (@) Never Expire | B Expiration Date:

Choose if your registration link will have an expiration date or not.

Math Captcha () Add Math Captcha to HTML Form | Do Not Use Math Captcha in HTML Form

Add math captcha exercise on HTML from registration to prevent spam registrations.
Math captcha is static and not changed as the form is inserted as an HTML code

Generate
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The Links Generated:

After clicking on the Generate button you will see get these details in the same screen, below the
Generate button:

Autoresponder Registration Link

Supports all autoresponders and registers members directly from emails you send to your mailing lists
in 1 click only.

This is the link generated by the MemberMouse 1-Click Registration you add inside the email:

Autoresponder Mail Merge Integration Link
This link should be used inside your autoresponder. Each autoresponder has a different format so make sure you have selected the correct auto responder.

http://sampleblog.info/membermouse?

mmaction=mm’cr_register&ar=ey]sljoiMSIsiImIliOm51bGwsInliOiltLS 1kZWZhdWxOLSOtliwibGeiOi]SZXMILCJ0ljp
udwWxsLCJlljoibmBiLCJIZCI6ZmFsc2UsImsiOi|KISZ0)V4y]FcOUESRKWSaRm|STVk4QFhlamR3I1zItR3ZwQORCazi4in0
=&f={Ifirstname}&I={!lastname}&e={!email}

Copy this link and put it in your outoresponder email HTML code

Rolling Members Registration Link

When members click on the link generated on membership site A they will be automatically registered
to membership site B in 1-click:

Register new members from another MemberMouse website
You can roll people from one MemberMouse membership site another to another using this HTML code:

<a href="http://sampleblog.info/membermouse?
mmaction=mm1cr_register&ar=ay|sljoiMsIsimliom51bGwsInliomS5 1 bGwsimxnljpudWxsLC)0ljpudWxsLdljpu
dWxsLCJIZCI6ZmFsc2UsImsiOijKISZ0|VAy]FcOUESRKWSaRm|STVk4QFhlamR31zItR3ZwQORCaz|4in0=8&f=
[MM_Member_Data name="firstname']&I=[MN_Member_Data name='lastname’&e=[MM_Member_Data
name="email']"=Activate Your Account Now=/a=

Copy this HTML code and put it in any other MemberMouse membership website inside the HTML code editor

HAPPY PLUGINS
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3-Fields Registration Form

Add a 3-fields only signup form in every post or page you like to register members to your
membership site:

Simple Signup Form
You can also create your own one-click registration form, where the only information your prospects have to fill out is their first name, last name, and email address.

All other registration details are generated automatically

<form action="http://sampleblog.info/membermouse" method="get"=<br /> e
First Name: =input type="text" name="firstname" /><br /><br />
Last Name: <input type="text" name="lastname" /=<br /=<br />
Email: <input type="text" name="email" /><br /><br /> -
How much is 1 + 3 ? <input type="text" name="math_captcha"=<br />

Copy this HTML code and put it in any other website that want. using a simple HTML code editor
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Step #6: Embedding the Links

After defining the settings and generating the links all you need to do is copy-paste them to the right
place according to their use.

Option #1 - Autoresponder Mail Merge Integration Link

1. Go to the Generator tab inside the plugin, choose the relevant settings and click on the
Generate button

2. To get the 1-click registration to work all you need to do is copy-paste the autoresponder link
into any email you send to your email list

3. Once a user clicks on the link he will be automatically registered and logged-in to the site, plus
will be redirected to the Thank You page

Option #2 - Roll members from another MemberMouse website

1. Activate MemberMouse 1-Click Registration in the NEW membership site where you want to
register members to

2. Go to the Generator tab, choose the relevant settings and click on the Generate button

3. Copy the HTML code under the headline: "Register new members from another
MemberMouse website"

4. Go to the OLD membership site where you want to roll members from and paste the HTML
code in the text editor of every relevant post or page. That's it!

Please note: In order for the link to work and register members from the old site to the new one,
members need to be logged in to the old site.

Option #3 - Simple Signup Form

1. Go to the Generator tab inside the plugin, choose the relevant settings and click on the
Generate button.

2. To make the signup form to work all you need to do is copy-paste the HTML code inside the
text editor of every post or page inside your membership site.
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Want a 1-field registration form?
You can hide the First and Last name fields to make the form display only the email.

All you need to do is follow these steps:

Delete the Change "text" to "hidden"

"First Name"

and "Last Can leave blank or write
Name" <form action="http://yourdomain€om" method="get"><br /> anything else you want

L FirstNamer<input type="hidden" name="firstname" /> r/>

EastName:<input type=" hidden" name="lastname" /><br /><br />
Email: <input type="text" name="email" /><br /><br />
<input type="hidden" name="action" value="wl1cr_register" />

<input type="hidden" name="ar"
value="eyJsljoiMTMyODMwNDAZzNClIsInliOilxNDg5NylsImxnljoieWVzliwidCl6lldpc2hsaXNOIDFDbGljay
BSZWdpc3RyYXRpb24iLCJIljoibm8iLCIIZCI6ZmFsc2UsimsiOilocWhlazY3elFydktUXIBkKOWZ3MOdNeXA
gWGOjTkBneFc4akQydDQ1In0="/>

<input type="submit" value="CLICK HERE: One Click Registration" /><br />

</form>
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Step #7: Using the Shortcodes

Since MemberMouse 1-Click Registration registers members to the site automatically, they will need
to get important details, such as their username and password, in order to be able to login to the site
in the future.

In the plugin's Dashboard tab you will find all the shortcodes that can be copied and pasted to the
after registration page to display the member his login details, including:

e Auto-generated username

e First name

e Lastname

e Password

e Email

o Level name

e Action (new member/ upgraded member)

IMPORTANT NOTE:

Since the information displayed in the shortcodes is sensitive, it will be available for 30 minutes from
the first time the page was loaded. Please add a note to your members to save the information on
their computer.

Screenshot:

ﬂ Dashboard | Settings  Generator License Information = Support = Other Products

Wishlist 1Click Registration - Dashboard

Wishlist 1Click Registration enables you to register new members to your website or add existing members to new levels just
by using a simple link.

You can distribute the link using any email service Wishlist Member supports.

You can use the below shortcodes in your after registration page to display the new member his membership information:
[wlcr_username] - Display the new member his auto-generated username.
[wlcr_firstname] - Display the new member his first name.
[wlcr_lastname] - Display the new member his last name.
[wlcr_password] - Display the new member his auto-generated password.
[wler_email] - Display the new member his email address.
[wler_levelname] - Display the new member the level he was registered to.

[wlcr_action] - Display a label of 'new' for a new members or a label of 'upgraded’ for an existing member that has been
upgraded to a new level.

[wlcr_new member] Content [wlcr_new_member]
Display this content only to a new member.

[wler_member_upgraded] Content [wlcr_member_upgraded]
Display this content only to a member that was already exists and his membership was upgraded to a new level.
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Step #8: Testing the Registration

After you copy-paste the links or signup form to the right location you need to test them and make
sure they are working correctly.

Checking the Autoresponder Link:
In order to check the autoresponder link all you need to do is send a test message of the email that
includes the 1-click registration link in it to your email.

When you receive the email, click on the link and see if the registration process is complete.

Important: please make sure that the email you are using doesn't already exist in your membership
site's database.

Checking the Rolling Members Link

In order to check that the link for rolling members from one membership site to another is working
correctly all you need to do is go to the OLD membership site where you pasted the 1-click
registration link to.

In order for the 1-click registration link to work you need to make sure:

1. That you are logged-in to the OLD membership site
2. Thatyou are not already registered to the NEW membership site with the same email

Now you can click on the link and see if you are being automatically registered to the NEW
membership site.

Checking the Signup Form
In order to check that the signup form works all you need to do is enter the relevant post or page and
fill-in the form's fields.

Before filling-in the signup form please make sure that:

1. You are not logged-in to the site
2. You are registering with a new email that does not exist in the database

What to do if the Registration Process is Not Working?

If you have encountered a problem in the registration process, please go to the Contact Information
section for more instructions.
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FAQS

Can MemberMouse 1-Click Registration plugin be used for paid membership
levels as well?

No, the plugin works for free membership levels only.

Can | change the after registration redirection page?

Yes, you can set a different redirection page to each membership level separately simply and easily
from the plugin’s Generator tab under “Select After Registration Page”.

Can MemberMouse Auto Registration work with any membership plugin?

No, MemberMouse 1-Click Registration is a MemberMouse dedicated plugin.

How will members get their login details?

MemberMouse 1-Click Registration allows you to add simple shortcodes to the After Registration page
with the log-in details and they will be available for 30 minutes (for security reasons), so they have
enough time to save them.

What details can | display members using the shortcodes?

Username, first name, last name, password (auto-generated), registration email, level name, action
(new/ upgrade) and a content box with your message
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About HappyPlugins

HappyPlugins was established in 2010 to develop plugins and extensions for the WordPress platform.

The majority of the plugins are developed as white label according to our clients’ specific
requirements.

In late 2010 we opened a new branch under HappyPlugins for developing MemberMouse dedicated
plugins called MemberMouse Developers.

Our team here at HappyPlugins develops both commercial and custom plugins.
Expertise
Our expertise includes:

* In depth knowledge and understating in the web industry
= UXIl design and improvement

= Experience in traffic and media buying for large companies
= Subscription-based marketing and retention

= Conversions and flow design optimization
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Contact information

The Store The Service The Blog

Find unique WordPress plugins  Looking for a special solution Interested in our development
on our plugins’ store. We have for WordPress, one that will work or want to improve your
designed and developed complete the missing puzzle WordPress development skills?
hundreds of custom plugins and  piece in your website? Please Check our blog; there we
solutions for customers so far send us your request and we publish unique prescriptive and
and are selling the best of them promise to return to you no sample codes from our own

in our store. later than 72 hours. plugins.

Contact Support

\

Our support team is always available to help you with any question you may have.

All of our products include 3 months of free support. Any support after that period of time
will be done in the community forums or as paid support.

Important:

Before contacting our support team, please check the following sources of information, as you may
find the answer you are looking for there:

1. Make sure you are always using the latest version of the plugin

2. Go over the documentation of the plugin including the Troubleshooting section
Open a Support Ticket

If you haven’t found your answer in any of the above sources, please open a support ticket through
our support helpdesk and we will get back to you in the next 72 hours.

Create a new ticket here
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Got Any Suggestions?

We are always looking for the next idea...
Do you have any ideas for new plugins?

We want to hear from you!

Please contact us and we might develop it as our next plugin.

Contact us here

Thanks!
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